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About this document 

These release notes include this information: 

• How to install the service pack 
• A list of the repaired defects that are included in the service pack  

Intended audience 
The intended audience of this document is a qualified database administrator.  
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Installing the service pack 

Infor strongly recommends that you install the service pack in a test environment for evaluation prior 
to updating the production environment. 

Updating an existing installation of VISUAL 10.0.0 
To update an existing installation of VISUAL, you must complete these procedures: 

• Backing up the SQL.ini file 
• Uninstalling 7.3.1 components 
• Installing the 7.3.3 runtimes 
• Updating VISUAL programs 
• Installing the Report Builder 
• Applying patch scripts 

Backing up the SQL.ini file 
Before you install the Gupta 7.3.3 runtimes, we recommend that you make a copy of your SQL.ini 
file and store it in a location that is unaffected by the installation process, such as the desktop. After 
you install the new runtimes, you can paste your existing SQL.ini file into your runtime directory. 

Uninstalling 7.3.1 components 
You must uninstall the 7.3.1 runtimes before installing the 7.3.3 runtimes.  

If you installed the Report Builder or the Object Nationalizer, you must also uninstall the 7.3.1 
versions of these components.  

Uninstall the runtimes on all application servers and clients. 

1 Click the Windows start menu and search for the Apps & features dialog. 

2 Click Team Developer 7.3 Deployment. Ensure that 7.3.1 is displayed. 
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3 Click Uninstall.  

4 Follow the prompts to remove the 7.3.1 runtimes. 

5 If you installed the Report Builder, uninstall it. In the Apps & features dialog, click Gupta Report 
Builder 7.3.1 and then click Uninstall. 

6 Follow the prompts to remove the Report Builder. 

7 If you installed the Object Nationalizer, navigate to the runtimes directory, and delete CNI73.exe. 

Installing the 7.3.3 runtimes 
NOTE: Uninstall the 7.3.1 runtimes before you begin this procedure. 

Infor VISUAL 10.0.0 Service Pack 1 requires the use of Gupta Runtimes version 7.3.3. If you are 
upgrading an existing installation of VISUAL 10.0.0, you must install the 7.3.3 runtimes.  

Install the runtimes on all application servers and clients. 

To install the runtime on either the client or the server: 

1 On your installation media, open InforInstallerVM.htm. 

2 Click Install Runtime Components ver 7.3.3. The InstallShield Wizard is launched. If the 
InstallShield Wizard is not launched automatically, then you can open it manually. Navigate to 
the runtime733 folder, right-click deploy-7.3.3-x86.exe, and select Run as Administrator. 

3 Click Next. 

4 Review the license agreement. If you agree, click I accept the terms of the license agreement. 

5 Click Next. 

6 Specify where to install the runtimes. You can use the same directory where you originally 
installed the 7.3.1 runtimes, or you can specify a different directory, such as 
c:\Infor\Gupta\Runtime73.  

7 Click Next. 

8 Select the components to install. We recommend installing all components. The SQL Router for 
Oracle and SQL Router for ODBC components are required. 

9 Click Next.  

10 Review the installation settings. If you are satisfied with your selections, click Next. 

11 After the installation is complete click Finish to close the installation window. 

12 If you installed the runtimes in a different directory than the 7.3.1 runtimes, copy the SQL.ini file 
that you backed up in the “Backing up the SQL.ini file” procedure into the runtimes directory.  

13 Open the SQL.ini file.  

14 In the [win32client] section, ensure that the runtime directory is specified in the 
clientruntimedir= setting.  
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Updating VISUAL programs 
Use this procedure to update the executables, DLLs, QRPs, and other files. You do not need to 
reinstall the runtimes. 

1 From the disk or directory where you downloaded the service pack, double-click Setup.exe. 

2 Click Next. 

3 Select one of these options: 

Install VISUAL 10.0.0 Application Server Set Up 

Select this option to update your application server.  

Install VISUAL Full Installation on Stand Alone PC 

Select this option to install all VISUAL applications on a client. 

Install VISUAL 10.0.0 Client Only Setup 

Select this option to update the files that are used in a client installation. Client installation files 
include the user documentation, Pricebook files, COM files, and ActiveX controls. It will not install 
the full set of executables. When you select this option and then click Next, you are prompted to 
specify the location of VM.exe on your server.  

4 Click Next. The installer displays the path to your VISUAL directory. To install the programs in a 
different location, click the Change… button to specify a new location for the installation. 

5 Click Next. 

6 Click Install to begin the installation. 

7 Repeat the process for a full installation on all machines where you have installed all of the 
VISUAL executables. Repeat the process for a client installation on all machines that access 
VISUAL but do not have the full set of executables installed. 

Installing the Report Builder 
Install the report builder on any workstation or application server that will be used to customize 
standard reports.  

To install the report builder: 

1 On your installation media, open InforInstallerVM.htm. 

2 Click Install Report Builder 7. The InstallShield Wizard is launched. If the InstallShield Wizard 
is not launched automatically, then you can open it directly. In the ReportBuilder folder, double-
click setup.exe. 
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3 Click Next. 

4 Specify the directory where you installed the runtimes.  

5 Click Next. 

6 Click Install. 

7 Click Finish. 

Applying patch scripts 
Run the available patch scripts in sequential order. 

To verify your current patch script level, select Help > About from the main VISUAL menu. The 
current patch level is displayed on the Database and Patch Level line.  

1 Navigate to the directory where you store your VISUAL executables and launch the Conversion 
Utility, VMCVTUTL.exe. 

2 Sign in with SYSADM credentials. 

3 Verify that the information displayed for the database is correct. Correct any errors before 
proceeding. 

4 Click Run Script. 

5 Select the patch script to apply. For example, if the patch level of your database is 1000.0, apply 
patch script 1. Patch scripts are specific to the type of database that you use for VISUAL:  

• Oracle patch scripts begin with OR1000P 
• SQL Server patch scripts begin with SS1000P 

6 Click Open. The patch script is applied to the database. 

7 Repeat the process as necessary to install other patch scripts for your database type.   

Installing VISUAL 10.0.0 for the first time using the 
SP1 installer 
If you are upgrading from VISUAL 9.0.8 or earlier or if you have never installed Infor VISUAL, use 
the Infor VISUAL Applications Installation Guide to install VISUAL and its components.  

After you complete the procedures in the Applications Installation Guide, use the database 
installation guide for your database engine to create or update the VISUAL database. 

After you complete the procedures in the installation guide for your database engine, use this 
procedure to apply patch scripts for your database: 
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1 Navigate to the directory where you store your VISUAL executables and launch the Conversion 
Utility, VMCVTUTL.exe. 

2 Sign in with SYSADM credentials. 

3 Verify that the information displayed for the database is correct. Correct any errors before 
proceeding. 

4 Click Run Script. 

5 Navigate to the patch script 1 for your database type: 

• For Oracle, navigate to OR1000P01. 
• For SQL Server, navigate to SS1000P01. 

6 Click Open. The patch script is applied to the database. 

7 Repeat step 4 through 6 for the other patch scripts for your database type.  
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Enhancements 

This service pack introduces updated runtimes and an enhancement to the API Toolkit Database 
Registration utility. 

Gupta 7.3.3 runtimes 
Use of the Gupta 7.3.3 runtimes is required. The updated runtimes resolve these issues: 

• Display problems in the Scheduling window 
• Compatibility with Infor VISUAL Payroll and Infor VISUAL HR 

Email addresses for notifications 
You can now configure the API Toolkit to use different sender credentials for each notification type. 

For more information, see “Setting up email notifications” in the Infor VISUAL API Toolkit Database 
Registration Guide. 
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Resolved issues 

This table lists the issues that are resolved in the service pack. The table shows the application 
name, file name, version number, defect number, and description of the resolution. The table is 
sorted by application name. 

Table entries with an application name of “VISUAL API Toolkit” represent a group of files that must 
be updated together to work properly. See Appendix A.  

* Indicates that the file is included in both a client installation and a full installation. Files without the 
asterisk are not included in the client install. 

Application Name File Name Defect  Description 

A/P Invoice Entry VFAPIENT 765199 Fixed an issue with incorrect distributions to 
the purchase return expense account. 

A/P Invoice Entry VFAPIENT 694134 Fixed issue with receiving a divide by zero 
error when vouchering a receiver when the 
discount percentage on the associated 
purchase order is changed to 100% after 
receipt.  

A/P Invoice Entry VFAPIENT 726262 Fixed issue with invoice being saved in 
error after failing a workflow condition. 

A/P Invoice Entry VFAPIENT 731366 Fixed issue with fixed charges not being 
pulled in from outside service purchase 
orders. 

A/P Invoice Entry VFAPIENT 739578 Fixed issue with incorrect VAT code being 
used when VAT code on purchase order 
differs from VAT code on the vendor. 

A/P Invoice Entry VFAPIENT 742760 Fixed issue with Alt+R keyboard command 
not functioning. 

A/P Invoice Entry VFAPIENT 743041 Fixed issue with the VFAPVVAT.QRP not 
being used when printing a Voucher in a 
VAT-enabled entity. 

A/P Invoice Entry VFAPIENT 744861 Fixed issue with OnSave macro that 
references a user-defined field. 
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Application Name File Name Defect  Description 

A/P Invoice Entry VFAPIENT 746294 Fixed an issue with not all currencies being 
displayed when resetting exchange rates on 
an invoice line that has not yet been saved. 

A/P Invoice Entry VFAPIENT 750151 Fixed issue with incorrect posting value to 
the PRA account when the source of raw 
material cost is based on the purchase 
order. 

A/P Invoice Entry VFAPIENT 750152 Fixed issue with receiving an error after 
editing exchange rates. 

A/P Invoice Entry VFAPIENT 750212 Fixed issue with the work order ID browse 
not being filtered by site. 

A/P Invoice Entry VFAPIENT 751263 Fixed issue with users who do not have 
access to VISUAL applications being able 
to access VISUAL applications. 

A/P Invoice Entry VFAPIENT 752101 Fixed issue with service receipts generating 
incorrect WIP and Purchase journals. 

A/P Invoice Entry VFAPIENT 755836 Fixed issue with receiving a "You may not 
change quantity to be unequal to received 
quantity" message after manually entering a 
receiver line on non-landed cost site. 

A/R Collections VFARCLCT 755100 Fixed issue with invoice header and line 
specifications not being printed on the 
invoice. 

A/R Customer 
Inquiry 

VFARCINQ 755100 Fixed issue with invoice header and line 
specifications not being printed on the 
invoice. 

A/R Invoice Entry VFARIENT 730192 Fixed issue with free-form information 
entered in the template not being included 
when emailing invoices. 

A/R Invoice Entry VFARIENT 746548 Fixed issue with the duplication of 
transactions when printing GL Transactions 
by Batch ID. The issue occurred if the same 
Batch ID was used in more than one site. 

A/R Invoice Entry VFARIENT 747536 Fixed issue with invoice printed in 
Manufacturing printing the wrong ship to 
address if the address was changed on the 
packlist. 

A/R Invoice Entry VFARIENT 747818 Fixed issue with the layout of the Bill To 
address on invoices. 
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Application Name File Name Defect  Description 

A/R Invoice Entry VFARIENT 755100 Fixed issue with invoice header and line 
specifications not being printed on the 
invoice. 

Accounting 
Window 

VFGLAWIN 748482 Fixed issue with negative posting 
candidates being displayed for the 
adjustments journal. 

Application Global 
Maintenance 

VMAPLGLB 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 

Application Global 
Maintenance 

VMAPLGLB 691809 Fixed issue with work email address not 
being synchronized to Infor Quality 
Management. 

Average Costing 
Application 

VFAVGCST 691376 Fixed issue with average costing application 
consuming a user license. 

BOD to Database 
Service 

BOD2DBSRVC 691809 Fixed issue with work email address not 
being synchronized to Infor Quality 
Management. 

BOD to Database 
Service 

BOD2DBSRVC 726715 Fixed issue to prevent the import of parts 
that have a Deleted status in the 
ItemMaster BOD. 

Check Indexes VMCHKIDX 666136 Fixed issue with missing Oracle indexes. 

Contact 
Maintenance 

VMCONMNT 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 

Costing Tools VMAPLTLS 723404 Fixed issue with the duplication of shipment 
entries that have multiple distributions.  

Costing Tools VMAPLTLS 726778 Fixed issue with Close/Reopen period 
displaying sales journal candidates when 
zero value RMA returns had been made. 

Costing Tools VMAPLTLS 734309 Fixed issue with incorrect values in the 
Average Cost Analysis report. 

Costing Tools VMAPLTLS 743821 Fixed issue with the recalculation of 
standard cost not considering unit of 
measure conversions. 

Costing Tools VMAPLTLS 749954 Fixed issue with gross negative values 
causing arithmetic overflow errors in the 
INV_TRANS_CUR table. 
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Application Name File Name Defect  Description 

Costing Tools VMAPLTLS 752953 Fixed issue with filtering by site when 
viewing exceptions. 

Costing Tools VMAPLTLS 756749 Improved performance of costing when 
issue return transactions have a large 
number of linked distribution transactions.  

Costing Utilities VMAPLUTL 726778 Fixed issue with Close/Reopen period 
displaying sales journal candidates when 
zero value RMA returns had been made. 

Costing Utilities VMAPLUTL 733581 Fixed messages to state that Shipping 
Intercompany and Receiving Intercompany 
accounts must be set up after upgrading a 
7.0.0 database with multiple entities to a 
single-site 9.0.8 database. 

Costing Utilities VMAPLUTL 749954 Fixed issue with gross negative values 
causing arithmetic overflow errors in the 
INV_TRANS_CUR table. 

Costing Utilities VMAPLUTL 750778 Fixed issue with receiving a SQL error 
when a burden ID exists in two project 
summaries and the same burden cost 
category ID is used in both project 
summaries. 

Costing Utilities VMAPLUTL 756749 Improved performance of costing when 
issue return transactions have a large 
number of linked distribution transactions.  

Customer 
Maintenance 

VMCUSMNT 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 

Customer 
Maintenance 

VMCUSMNT 747691 Fixed issue to prevent saving a row in the 
Part Pricing table if no unit price or quantity 
has been specified. 

Customer 
Maintenance 

VMCUSMNT 751892 Fixed issue with Web ID and passwords 
being transposed on alternate contacts. 

Customer Order 
Entry 

VMORDENT 681702 Fixed issue with the display of the Unit 
Price field in the Order Acknowledgement 
form to include the currency symbol and the 
correct number of decimal places. 

Customer Order 
Entry 

VMORDENT 697650 Fixed issue with program existing when 
creating a work order from an MPC line that 
has requirement specifications. This issue 
occurred on Oracle databases. 
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Application Name File Name Defect  Description 

Customer Order 
Entry 

VMORDENT 705240 Fixed issue with auto-browse not 
functioning on the Customer PO field. 

Customer Order 
Entry 

VMORDENT 729411 Fixed an issue with being unable to save a 
document at the site level. 

Customer Order 
Entry 

VMORDENT 737045 Fixed an issue with being unable to save a 
document at the site level. 

Customer Order 
Entry 

VMORDENT 738997 Fixed issue with receiving a message in 
error when generating an order from a 
quote for a customer that uses Due Date to 
determine the oldest open invoice. 

Customer Order 
Entry 

VMORDENT 746970 Fixed issue with the format of decimal 
digits. 

Customer Order 
Entry 

VMORDENT 748471 Fixed issue with the population of the 
contact salutation field. 

Customer Order 
Entry 

VMORDENT 751873 Fixed issue with resetting fixed rates in 
Exchange Rate dialog not resetting the 
fixed rate used in Project Info. 

Customer Order 
Entry 

VMORDENT 754557 Fixed issue with incorrect discount 
percentage being applied after changing the 
customer ID. 

Customer Orders' 
Deferred Revenue 

VMPBCRP2.QRP 739880 Fixed issue with incorrect values being 
used in the Deferred Revenue Status 
report. 

Drum-Buffer-Rope 
Scheduler 

VMDBR.DLL 727224 Fixed issue with being unable to schedule a 
work order that contains an operation with a 
Max Gap value. 

ECN Entry VMECNENT 666015 Fixed issue with work order documents that 
are added through drag-and-drop being 
saved to the wrong directory. 

Employee 
Maintenance 

VMEMPMNT 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 

Employee 
Maintenance 

VMEMPMNT 691809 Fixed issue with work email address not 
being synchronized to Infor Quality 
Management. 

Estimating 
Window 

VMESTWIN 729411 Fixed an issue with being unable to save a 
document at the site level. 
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Application Name File Name Defect  Description 

Estimating 
Window 

VMESTWIN 737045 Fixed an issue with being unable to save a 
document at the site level. 

Estimating 
Window 

VMESTWIN 746462 Fixed issue with updates to Run Type not 
being saved in Quick Quote. 

Estimating 
Window 

VMESTWIN 748471 Fixed issue with the population of the 
contact salutation field. 

Financials Main 
Menu Window 

VF 751263 Fixed issue with users who do not have 
access to VISUAL applications being able 
to access VISUAL applications. 

General Journal 
Entry 

VFGLTENT 718069 Fixed issue with recurring journal entries 
not considering the financial calendar. 

General Journal 
Entry 

VFGLTENT 730003 Fixed an issue with being unable to import a 
general journal with only one user 
dimension. 

General Journal 
Entry 

VFGLTENT 754040 Fixed issue with pasting journal entries with 
negative values zeroing out the incorrect 
table cell. 

Global Scheduler 
DLL 

VMGLBDLL.DLL 727224 Fixed issue with being unable to schedule a 
work order that contains an operation with a 
Max Gap value. 

Inventory Costing 
Service 

VMCSTSVC 726778 Fixed issue with Close/Reopen period 
displaying sales journal candidates when 
zero value RMA returns had been made. 

Inventory Costing 
Service 

VMCSTSVC 733581 Fixed messages to state that Shipping 
Intercompany and Receiving Intercompany 
accounts must be set up after upgrading a 
7.0.0 database with multiple entities to a 
single-site 9.0.8 database. 

Inventory Costing 
Service 

VMCSTSVC 749954 Fixed issue with gross negative values 
causing arithmetic overflow errors in the 
INV_TRANS_CUR table. 

Inventory Costing 
Service 

VMCSTSVC 756749 Improved performance of costing when 
issue return transactions have a large 
number of linked distribution transactions.  

Inventory 
Transaction Entry 

VMINVENT 745344 Fixed issue with Warehouse field not 
refreshing correctly after completing an 
adjust in or adjust out. 
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Application Name File Name Defect  Description 

Inventory 
Transaction Entry 

VMINVENT 751249 Fixed issue with selection of Auto Process 
Label Before Clear option not persisting 
between sessions. 

Inventory 
Transaction Entry 

VMINVENT 752810 Fixed issue to filter warehouse locations by 
site in project databases. 

Inventory 
Transaction Entry 

VMINVENT 754718 Fixed issue with  being able to assign 
remaining quantities for pre-assigned trace 
after some trace IDs are assigned to 
another transaction. 

Inventory 
Valuation Report 

VMPIVRPT 719779 Fixed issue with imploding cost in Inventory 
Valuation Report removing purchase 
burden cost from a part in Part 
Maintenance. 

Invoice Forms VMINVGEN 730192 Fixed issue with free-form information 
entered in the template not being included 
when emailing invoices. 

Invoice Forms VMINVGEN 737560 Fixed issue with PDF file name using the 
packlist ID instead of the invoice ID in 
certain circumstances. 

Invoice Forms VMINVGEN 754244 Fixed issue with receiving a SQL syntax 
message when emailing invoices that have 
Combine All Packlists for an Order check 
box selected. 

Invoice Forms VMINVGEN 754270 Fixed issue with duplicate invoices not 
being printed. 

Invoice Forms VMINVGEN 755352 Fixed issue with receiving a network 
resource conflict error when Combine All 
Packlists check box is selected during the 
print of a single invoice. 

Invoice Forms VMINVGEN 757249 Fixed issue with duplicate copies of 
PDF/RTF files being created when emailing 
invoices. 

Labor Entry VMLABENT 679514 Fixed issue to save the labor ticket after 
pressing ALT-S. 

Make BOD from 
external 
application 

VMAKEBOD 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 
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Application Name File Name Defect  Description 

Manufacturing 
Main Menu 

VM 746880 Fixed issue with Add Customer permission 
being listed in VMPRTMNT section and Add 
Part permission being listed in VMCUSMNT 
section in the Security report.  

Manufacturing 
Main Menu 

VM 751263 Fixed issue with users who do not have 
access to VISUAL applications being able 
to access VISUAL applications. 

Manufacturing 
Window 

VMMFGWIN 666015 Fixed issue with work order documents that 
are added through drag-and-drop being 
saved to the wrong directory. 

Manufacturing 
Window 

VMMFGWIN 678496 Fixed issue with the display of the 
warehouse ID on the leg header when the 
warehouse is inherited. 

Manufacturing 
Window 

VMMFGWIN 679037 Fixed issue with incorrect calculated 
quantities when a replacement part has a 
per quantity of 0. 

Manufacturing 
Window 

VMMFGWIN 684747 Fixed issue with copying and pasting 
operations from one project to another not 
using the correct warehouse ID and WBS 
code. 

Manufacturing 
Window 

VMMFGWIN 685213 Fixed issue with user being able to update 
the Eng ID without permission. 

Manufacturing 
Window 

VMMFGWIN 691265 Fixed issue with save prompt being shown 
in error after specifying a vendor ID and 
clicking Save. 

Manufacturing 
Window 

VMMFGWIN 715187 Fixed an issue with receiving an "Unable to 
save CCR" message when changing the 
buffer on a work order with no want date. 

Manufacturing 
Window 

VMMFGWIN 737045 Fixed an issue with being unable to save a 
document at the site level. 

Manufacturing 
Window 

VMMFGWIN 744971 Fixed issue with receiving errors when 
copying and pasting operations that have 
pictures or objects. 

Material Planning 
Window 

VMPLNWIN 731350 Fixed issue with description field in 
Inventory Transactions dialog not showing 
all 120 characters. 

Material Planning 
Window 

VMPLNWIN 755411 Fixed issue to display all 120 characters of 
the part description. 
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Application Name File Name Defect  Description 

Notifications 
Maintenance 

VMNTFMNT 614717 Fixed issue with not being prompted to save 
changes after deleting information, clicking 
Refresh, and then exiting the window 
without saving. 

Notifications 
Maintenance 

VMNTFMNT 614717 Fixed issue with not being prompted to save 
changes after deleting information, clicking 
Refresh, and then exiting the window 
without saving. 

Notifications 
Maintenance 

VMNTFMNT 730192 Fixed issue with free-form information 
entered in the template not being included 
when emailing invoices. 

Oracle 1000 Patch 
Script 01 

OR1000P01.SQL 565552 Fixed issue with the calculation of customer 
credit balance after the application of a 
cash receipt. 

Oracle 1000 Patch 
Script 01 

OR1000P01.SQL 756749 Improved performance of costing when 
issue return transactions have a large 
number of linked distribution transactions.  

Order 
Management 
Window 

VMORDWIN 681702 Fixed issue with the display of the Unit 
Price field in the Order Acknowledgement 
form to include the currency symbol and the 
correct number of decimal places. 

Order 
Management 
Window 

VMORDWIN 697650 Fixed issue with program existing when 
creating a work order from an MPC line that 
has requirement specifications. This issue 
occurred on Oracle databases. 

Order 
Management 
Window 

VMORDWIN 705240 Fixed issue with auto-browse not 
functioning on the Customer PO field. 

Order 
Management 
Window 

VMORDWIN 729411 Fixed an issue with being unable to save a 
document at the site level. 

Order 
Management 
Window 

VMORDWIN 737045 Fixed an issue with being unable to save a 
document at the site level. 

Order 
Management 
Window 

VMORDWIN 738997 Fixed issue with receiving a message in 
error when generating an order from a 
quote for a customer that uses Due Date to 
determine the oldest open invoice. 



Resolved issues 

20 | Infor VISUAL 10.0.0 Service Pack 1 Release Notes 

Application Name File Name Defect  Description 

Order 
Management 
Window 

VMORDWIN 751873 Fixed issue with resetting fixed rates in 
Exchange Rate dialog not resetting the 
fixed rate used in Project Info. 

Outside Service 
Dispatch Entry 

VMSRVDIS 753442 Fixed issue to allow more than 1000 rows to 
be displayed in the table. 

Part Maintenance VMPRTMNT 684716 Fixed issue with the display of location IDs 
in the Location for Part dialog for parts that 
include brackets in the part ID.  

Part Maintenance VMPRTMNT 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 

Part Maintenance VMPRTMNT 705486 Fixed issue with the display of total cost 
with burden when Costs tab is not the 
default tab. 

Part Maintenance VMPRTMNT 719779 Fixed issue with imploding cost in Inventory 
Valuation Report removing purchase 
burden cost from a part in Part 
Maintenance. 

Part Maintenance VMPRTMNT 740483 Fixed issue with Min/Max Order Qty and 
Order Policy information not being saved 
when selecting File > Save. 

Part Maintenance VMPRTMNT 751286 Fixed issue to prevent changing a unit of 
measure for a part if it the part is used on a 
customer order, purchase order, or quote. 

Part Maintenance VMPRTMNT 755354 Fixed issue with Not Planned being 
selected for Order Policy in independently 
planned warehouses. 

Payable Inquiry VFAPVINQ 691687 Fixed an incorrect currency valuation in the 
Payment Applied column. 

Payable Inquiry VFAPVINQ 751263 Fixed issue with users who do not have 
access to VISUAL applications being able 
to access VISUAL applications. 

Physical Inventory 
Count 

VMPHYINV 685706 Fixed issue with being unable to print blank 
tags when assigning a starting and ending 
tag number. 

Physical Inventory 
Count 

VMPHYINV 734898 Fixed issue with the duplication of purchase 
burden costs when the site's parent entity 
uses standard costing. 
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Application Name File Name Defect  Description 

Physical Inventory 
Count 

VMPHYINV 745826 Fixed issue with recount not showing the 
correct sub-tags total quantity. 

Post 
Manufacturing 
Journal 

VFMFGJRN 754604 Fixed issue with Print G/L Transactions 
dialog selection resetting from Print All to 
Purchases. 

Progress Billing 
Entry 

VMPBCENT 739872 Fixed issue on the Invoice Status Report to 
retrieve the correct converted currency 
values from receivable distributions. 

Progress Billing 
Entry 

VMPBCENT 739880 Fixed issue with incorrect values being 
used in the Deferred Revenue Status 
report. 

Project Billing 
Entry 

VMPRJBNT 737220 Fixed issue with amounts not being 
calculated correctly when a project is not 
created with the default entity currency. 

Project Revenue 
Recognition 

VMREVREC 524482 Fixed issue with shipments that have zero 
unit costs not being included for selection. 

Project Summary 
Window 

VMPRJSUM 743747 Fixed issue with incorrect currency symbol 
being used in the Project Summary Window 
when creating a new ETC from an existing 
ETC. 

Purchase 
Management 
Window 

VMPURWIN 465044 Fixed issue with receiving an error message 
when entering a Vendor Part ID on a line 
that contains a demand-supply link. 

Purchase 
Management 
Window 

VMPURWIN 744087 Fixed issue with SQL cursors not being 
disconnected when using the Part View 
Panel. 

Purchase 
Management 
Window 

VMPURWIN 755278 Fixed issue with vendor bank ID field not 
being cleared when copying a purchase 
order for a vendor with a bank ID and then 
updating the vendor on the purchase order 
to one without a bank ID. 

Purchase Order 
Entry 

VMPURENT 465044 Fixed issue with receiving an error message 
when entering a Vendor Part ID on a line 
that contains a demand-supply link. 

Purchase Order 
Entry 

VMPURENT 532026 Fixed issue with the update of the VAT code 
after changing the vendor. 

Purchase Order 
Entry 

VMPURENT 744087 Fixed issue with SQL cursors not being 
disconnected when using the Part View 
Panel. 
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Application Name File Name Defect  Description 

Purchase Order 
Entry 

VMPURENT 748471 Fixed issue with the population of the 
contact salutation field. 

Purchase Order 
Entry 

VMPURENT 755278 Fixed issue with vendor bank ID field not 
being cleared when copying a purchase 
order for a vendor with a bank ID and then 
updating the vendor on the purchase order 
to one without a bank ID. 

Purchase 
Requisition Entry 

VMREQENT 731113 Fixed issue with required field indicator not 
being displayed in Approval Groups fields. 

Purchase 
Requisition Entry 

VMREQENT 741259 Fixed issue with required field indicator not 
being displayed in Approval Groups fields. 

Purchase 
Requisition Entry 

VMREQENT 756339 Fixed issue with receiving an unrecoverable 
error after editing exchange rates. 

Query Tool VMQUERY 746323 Fixed issue with Query Tool drill-down not 
opening the preferred order entry program. 
Also fixed issue with missing order lines. 

Receiving VMRCVENT 729691 Fixed an issue with receiving a "There are 
no new quantities received to save" 
message when a macro exists in the 
program. 

Receiving VMRCVENT 746443 Fixed issue with PO return transactions not 
populating WBS code, Project Sun ID, and 
Project Sequence ID when returned goods 
were purchased directly to the project 
warehouse. 

Return Material 
Authorization 
Entry 

VMRMAENT 744784 Fixed issue with RMA Acknowledgment 
being blank when RMAs are for parts that 
are not shipped in VISUAL. 

Return Material 
Authorization 
Entry 

VMRMAENT 755281 Fixed issue with invoices tied to an RMA 
not being displayed in the Document 
Lifecycle viewer. 

Revaluation VFREVALU 741433 Fixed issue with revaluation not being 
calculated correctly when a currency is 
used by multiple entities. 

Revaluation VFREVALU 746418 Fixed issue with revaluation ID browse table 
not being filtered for the selected site. 

Run Query VMQRYRUN 746323 Fixed issue with Query Tool drill-down not 
opening the preferred order entry program. 
Also fixed issue with missing order lines. 
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Application Name File Name Defect  Description 

Sales Commission 
Report 

VMCSRRPT 743455 Fixed issue with incorrect reporting 
currency values being displayed on the 
Sales Commission report. 

Shipping Entry VMSHPENT 524482 Added an error message when deleting a 
packlist with existing revenue recognition 
distribution entries. 

Shipping Entry VMSHPENT 661484 Added a save prompt wen users change 
information on the Other tab in the Edit 
Packlist dialog. 

Shipping Entry VMSHPENT 693575 Fixed issue with the allocated quantity 
being incorrect when a shipment return is 
made for a credit RMA. 

Shipping Entry VMSHPENT 743312 Fixed issue with Shipping Charge Account 
information not being retained when printing 
a Before Shipment packlist. 

Shipping Entry VMSHPENT 745212 Fixed issue with customer order line being 
required instead of packlist line number 
when printing traceable part shipping labels. 

Shipping Entry VMSHPENT 752095 Fixed issue with account ID not being 
copied to a backorder. 

Shipping Entry VMSHPENT 752313 Fixed issue with failure to receive an error 
message after making a shipment in an 
accounting period that has not been set up. 

Shop Resource 
Maintenance 

VMRESMNT 747980 Fixed issue with resource calendars having 
more than 24 hours in a day. 

Sql Server 1000 
Patch Script 01 

SS1000P01.SQL 565552 Fixed issue with the calculation of customer 
credit balance after the application of a 
cash receipt. 

Sql Server 1000 
Patch Script 01 

SS1000P01.SQL 756749 Improved performance of costing when 
issue return transactions have a large 
number of linked distribution transactions.  

Task Maintenance VMTSKMNT 738335 Fixed issue with workflow that is set up to 
send emails when purchase order request 
status is changed not sending an email 
after a purchase order request is approved. 

Vendor 
Maintenance 

VMVNDMNT 691151 Fixed issue with the creation of BODs for 
site IDs or entity IDs that include an 
ampersand (&). 
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Application Name File Name Defect  Description 

Vendor RFQ Entry VMRFQENT 677054 Fixed issue with user-defined fields being 
cleared when access RFQ Entry from 
another program. 

Warehouse 
Maintenance 

VMWHSMNT 737090 Deactivated the Add Location to 
Warehouses option in the Edit menu when 
user is in read-only mode. 

Wedge Barcode 
Labor Ticket Entry 

VMBCLABR 678796 Fixed issue with setup time being included 
in the calculation for quantity complete. 

Wedge Barcode 
Labor Ticket Entry 

VMBCLABR 753400 Fixed issue with Good Qty field remaining 
disabled for subsequent work orders after a 
work order that calculates quantity complete 
by hours has been retrieved.  



Appendix A: API Toolkit 

Infor VISUAL 10.0.0 Service Pack 1 Release Notes | 25 

Appendix A: API Toolkit 

The VISUAL API Toolkit is a group of files that must be updated together to work properly.  

The toolkit is composed of these files: 

• Dynamic link libraries: 

LSACORE.DLL 

LSASHARED.DLL 

MICROSOFT.SCRIPTING 

MICROSOFT.SCRIPTING.METADATA 

ORACLE.MANAGEDDATAACCESS.DLL 

ORACLE.MANAGEDDATAACCESSDTC.DLL 

VMFGFINANCIALS.DLL 

VMFGINVENTORY.DLL 

VMFGPURCHASING.DLL 

VMFGSALES.DLL 

VMFGSHARED.DLL 

VMFGSHOPFLOOR.DLL 

VMFGTRACE.DLL 

• Executable: 

VMFGCONFIGFORMS.EXE 

• Configuration: 

VMFGCONFIGFORMS.EXE.CONFIG 

• Samples: 

VMFGSAMPLESAPITOOLKIT.ZIP 
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